
Help for Ultimate Children's Encyclopedia
Click here to see the complete Help contents list.
Welcome to my room! At first sight, it looks like an ordinary kid's room, doesn't it? But 
there's nothing ordinary about it, once you put on my goggles! When you put them on, 
the room fills up with magical doorways into fun, fact-filled worlds. Just move your 
mouse around to see what I mean.

As you move around the room, you'll see topic names appear--like if you move over my 
chemistry set, you'll see the topic "Science." There are seventeen different topics in all. 
When you see one you want to learn about, just click it. You'll be taken to a topic 
screen where you can choose an article to explore.

The other cool thing about my goggles is that they include tools specially made for 
exploring and learning, like a journal, and a Find feature and a dictionary.
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The Topic Screen

When you click a topic in my room, you're taken to a topic screen, where you can 
narrow your focus and choose an article to explore.

Each topic is sorted into two or more categories. Click a category and the article list will 
show only the articles in that category. Click See All and the article list will show all the 
articles in all the categories for that topic. (When you select a topic and the topic screen 
appears, See All is automatically selected, so you can see all articles for that topic right 
away.)

If you know exactly what you want to find, type it in the box at the top of the topic screen
and press Enter. If you just want to browse through the list, click the down arrow.

When you find an article you want to see, click on its name or icon.

Each time you access a topic screen, I'll be there to help. I've been exploring the 
Childrens Encyclopedia materials for a while now, so I can offer tips on interesting 
things to look up and ways to help you work smarter.

To return to my room, click Go To Room at the bottom left of the screen. Click the Go 
Back arrow, in the top left corner of the screen, to return to the previous screen.

Click here to see the complete Help contents list.



The Article Screen
The article screen is pretty simple:    article text on the left, related multimedia on the 
right.

To read the article, use the arrows to scroll through the text. If you see a 
word you don't know, click it and the dictionary will show you the word's 
definition. (To return to the article from the dictionary, click the Go Back arrow in the 
top left corner of the screen.)

Each article includes icons. Those are the little pictures you see under the article text. 
Some articles have only one or two icons, while others have lots. Click here to find out
more about the icons you'll find in articles.

When you open an article, the program automatically shrinks or enlarges the related 
picture to fit the article screen. For a better view of the picture, click the Picture Size 
button in the top right corner of the screen. Click the button again to return to the article 
screen.



The Dictionary & Thesaurus
There are two ways to access the dictionary and thesaurus: click a word in an article or 
caption to see the definition of that word or just click the Dictionary/Thesaurus button 
in the bottom left corner of the screen.

The dictionary/thesaurus screen consists of three areas: the entry box, the word list, 
and the definition area.

Use the entry box to find a specific word quickly. Simply type an entry and press Enter.

To browse the word list, use the up and down arrows. To see a word's definition and 
thesaurus entry, simply click the word in the word list.

The definition area displays the dictionary and thesaurus entries for the selected word. 
Use the up and down arrows to scroll through long entries.

Have you ever looked up a word to find out what it means, only to find that the definition
itself contains a word you don't know? If that happens to you in this dictionary, just click 
the word you don't know and you'll see its definition!

Click here for details on the dictionary and thesaurus contents.



The Timeline
Some articles are linked to a timeline so you can learn about one or more important 
events related to the article's subject. If you see a timeline icon in an article, click it to 
open the timeline. If there is more than one related timeline entry, a list will appear when
you click the timeline icon. Click the entry you want to open the timeline.

The timeline screen automatically opens to the related timeline entry. To see other 
events that occurred around the same time, use the up and down arrows. To see the 
article related to another timeline entry, click the small article icon below it.

Ultimate Children's Encyclopedia contains two timelines: one that traces world history 
and one specifically about U.S. history. Click the World or USA button to select the 
timeline you want to see.

To see a specific year, click Go To Year. Then type a year, choose "A.D." or "B.C." and 
press Enter. If you change your mind, click Forget It to return to the timeline.



Venturing Online
Click the phone in my room for a ride on the information highway! From Ultimate 
Children's Encyclopedia, you can access the online service of your choice.
The first time you access the online feature, you have to tell the program where to find 
the software for your on-line service. Click here for details on how to configure 
Ultimate Children's Encyclopedia   for on-line service or to change the current   
configuration.
Once the program has been configured for your online service, just click the phone in 
my room and you'll be connected directly to your service.
A note to America Online trial subscribers:    If you are not already an America 
Online subscriber, you will be asked for subscriber information when you first launch the
service. The user ID and password that you will    need to log onto America Online as a 
new subscriber are shown on-screen before the AOL log-in screen. Be sure to jot down 
the ID and password so it will be handy when you need it.
After your initial session on America Online, you will be taken directly to the Compton's 
NewMedia Forum whenever you launch AOL from Ultimate Children's Encyclopedia.



Configuring Ultimate Children's Encyclopedia for Online Service
If you have not configured the program for on-line service, or if you want to change the 
current online setting, follow the steps below. 
To install the America Online software:

1. Load Ultimate Children's Encyclopedia and click the phone in my room.
2. Click Proceed at the On-Line welcome screen. You will be given the option to install 

the software for an America Online trial subscription.
To configure the program to use your existing on-line service:

1. Click the phone in my room.
2. Select Change Settings in the On-Line welcome screen.
3. In the On-Line settings window, click the small arrow to the right of the Online 

Application box and select an on-line application. If the service you want does not 
appear in the list, select Other. 

4. Make sure the path displayed in the Path box points to the appropriate .exe file for 
your on-line software. If necessary, use the Browse button or type the correct path 
in the Path box.

5. When the settings are correct, click OK.



All About Words
"All About Words" is one of my favorite features! To access this part of the program, 
click the All About Words button in the bottom left corner of the screen.

Here you'll learn about the English language and how it's used, and sharpen your 
writing skills as well as your understanding. You will find famous sayings, the meaning 
of wise sayings and proverbs, common phrases and idioms, what makes up a word, the
history of words, and get expert advice on using English properly.

Like the dictionary, the "All About Words" screen includes an entry box where you can 
type a search word, a list of words that you can scroll through and choose from, and a 
text area where you can read about your selection.

The little icons along the left side of the word list indicate which category the entries 
belong to--so an entry with a crocodile next to it is about common phrases and 
expressions, while an entry with a professor by it is an entry about English usage. 

Just like in the article screen, if you see a word you don't know in the text area, click it to
see its definition in the dictionary.



Finding Information

When you want to find specific information right away, click the Find button at the 
bottom of the screen.

At the Find screen, choose the kind of information you want:
Multimedia lists pictures, sounds and movies
Topic lists the seventeen topics in my room
All lists all the contents of Ultimate Children's Encyclopedia 
Idea lets you type a word or phrase to find related articles
Article lists all the articles in Ultimate Children's Encyclopedia 

Once you've chosen a type of information, type a search request in the entry box and 
press Enter, or click an item in the list to open it.

To close the Find box, click Forget It.



The Program Settings
The Settings button at the bottom of the screen allows you to customize some program
settings so that Ultimate Children's Encyclopedia will work the way you like best.

When the top setting says "Hints are on," I'll appear periodically to give you help with 
the program. Click Hints are on to turn off the hint feature. When the setting says "Hints
are off," I'll keep my comments to myself.

Click Your journal is... to choose the word processor you want to use as your journal. 
The default setting is Microsoft Write (in Windows 3.1) or WordPad (in Windows 95).

Click Advanced Settings to access additional program settings. Here you can select 
the online service you want to use and set the speed of the opening animation, which 
plays automatically when you start the program.

A note about the opening animation: If your computer has trouble playing the 
opening animation, the program automatically displays a window where you can reset 
the animation's playback speed. To disable this window, click the box next to "Don't 
display setting window." When there is an "x" in this box, the animation speed window 
will not appear.



Getting Help
Whenever you need quick information about a program feature, click the Help button at 
the bottom of the screen. When the cursor changes into a question mark, click on the 
feature you want explained.

For additional help information, press F1. The help screen will display information about 
the feature that is currently on-screen.

For help using the Windows Help feature, press F1 while the help window is on-screen.



Copying Articles & Media

To copy the text of an article, click the Copy button, then select the Article icon. If you 
want to copy only a portion of an article, highlight the text you want to copy before 
clicking the Copy button. 

To copy a picture, make sure the picture you want is on screen, click the Copy button, 
then select the Picture icon.



Picture Fact Icon

When you click the Picture Facts icon, a description of the current picture opens. When
you're done reading the description, click Forget It to close it.

If you come across a word you don't know, click it to see its definition.



Related Articles Icon

When you click a Related Articles icon, you'll see a list of articles that are related to the
one on-screen. Click an article title to see the related article. To return to the original 
article, click the Go Back arrow in the top left corner of the screen.

To close the Related Articles feature, click Forget It.



Quitting the Program

It's so much fun exploring with you, I wish you'd never have to leave. But, of course, you
have to sleep sometime, don't you! When you're ready to leave Ultimate Children's 
Encyclopedia, click the Quit button in the bottom left corner of the screen.

If you have second thoughts about leaving, click Forget It to return to the program.



Printing Articles & Media

To print the text of an article, click the Print button, then select the Article icon. If you 
want to print only a portion of an article, highlight the text you want to print before 
clicking the Print button. 

To print a picture, click the Print button and then select the Picture icon.



Go To Year
When the timeline is on-screen, and you want to see a specific year or time period, click
Go To Year. Then, in the entry box, type the year you want to see, click on the "A.D." or 
"B.C." button, and press Enter. The "Go To Year" feature will close and the timeline will 
display the year you entered.



Technical Assistance
This product has been extensively tested and we expect that most customers will be enjoying Ultimate 
Children's Encyclopedia without ever needing to read this section. In the event that there is a conflict on 
your system, we are here to help.

Windows 95 promises to be a great advancement in the world of operating systems. However, due to the 
recent release of this software, extensive troubleshooting data is not yet available. Be sure to check the 
readme.txt file on the CD for last-minute information, and let us know your experiences with Windows 95 
and Ultimate Children's Encyclopedia.

The Self-Help Tools section offers leads on diagnostic tools and do-it-yourself tips.

The Frequently Asked Questions sections list common questions and suggest solutions for Windows 3.1.

The WAV and MIDI Music Issues section offers tips on playing sound files on your system.

The Contacting Technical Support section lists various ways to obtain technical support.



Self-Help Tools
We have found that many of our customers prefer to use "self-help" tools, so we have taken steps to 
provide as many of these as possible.

* If you're not sure what components are installed on your computer or what the program's system 
requirements are, we've added a utility which will report them to you. In the program, click Settings, 
then hold down the Ctrl key while selecting Meet the Crew.
If the program is not loaded, simply run the cnmsysi.exe file on the compact disc. 
* Windows 95 users: Run the cnmsysi.exe file in the \win32\ directory. 
* Windows 3.1 users: Run the cnmsysi.exe file in the \win\ directory.

* For a more in-depth view of your system, try one of these methods:
* Windows 95 users: Using the right mouse button, click on the My Computer icon in the top left 

corner of the desktop. Then select Properties from the pop-up menu that appears.
* Windows 3.1 users: Use the Microsoft Diagnostic utility that comes with MS-DOS and Windows. 

Simply go to the DOS prompt, type MSD and press Enter.
In addition, if you have questions about how Windows 3.1 is configured or if you need to make 
changes to your Windows 3.1 set-up, try the SysEdit command. Open the File menu in the 
Program Manager, and select Run. Then type sysedit and press Enter.

* MS-DOS offers extensive help information. Type help at the DOS prompt.
* If you encounter problems while installing the program, check the installation "log" file. This text file 

tells you what files have been installed, where they were installed, and any errors that occurred in the 
process. It can be very useful in determining where a problem may exist. Use a text editor or word 
processor to open the file called setupzak.log. You'll find it in the destination directory you specified 
during installation.

* This CD contains files that can be run "as is"--there is no file compression. If you need to manually 
install the program, simply copy the files from the \win32\ directory (Windows 95 users) or the \win\ 
directory (Windows 3.1 users) on the CD to a UCE directory on your hard drive, and create an icon to 
launch it. These files will occupy approximately 6 megabytes of hard disk space. Be sure to turn off 
the "read-only" file attributes on the files you have copied. If they remain "read-only" files, you will not 
be able to customize the Preferences for the program.

* You can install the America Online software without running or installing the program. Simply run the 
25instal.exe file in the \aolsetup directory on the compact disc. 

* Our Tech Support phone system has extensive "Question and Answer" sections available to assist 
you 24 hours a day. Any of these documents can be sent to the fax machine of your choice by 
selecting the Fax-On-Demand option. See Contacting Technical Support.



Frequently Asked Questions (Windows 3.1 only)
The following are questions asked by users with Windows 3.1 systems.

Q: Can I install Video for Windows without using the installation program?

A: The Microsoft Video for Windows utility can be run directly from this CD. Simply go to the \VFW11E\ 
directory on the CD and run setup.exe.

Windows 95 users:    Do not install Videos for Windows from the Ultimate Children's Encyclopedia CD 
onto your system. Windows 95 already includes the latest version of this software. Installing the version 
on the CD onto a Windows 95 system may result in system-wide conflicts. 

Q: What do I do about an error message that says: CDR-1O1 or Not Ready Reading (CD drive)?

A: Error messages related to the computer's ability to read the CD are often easy to resolve. The 
following steps should fix most read-errors: 

1. Make sure that the CD is clean and free of scratches. CDs can be washed in warm water and dish 
washing liquid. Scratched CDs should be replaced. 

2. Don't cache the CD drive. If your computer is using DOS version 6.20 or later and the SMARTDRV 
caching driver, add a /U argument to the line that loads SMARTDRV in your autoexec.bat file. The line
may appear as C:\DOS\SMARTDRV.EXE /X /U or something similar. For more information on 
SMARTDRV, type help smartdrv at the DOS prompt. 

3. Assign twenty buffers to reading the CD. This is done by setting the /M: argument on the MSCDEX 
line in your autoexec.bat file to 20. The line may appear as C:\DOS\MSCDEX.EXE /D:MSCD001 
/M:20 or something similar. For more information on Microsoft CD Extensions (MSCDEX), type help 
mscdex at the DOS prompt. 

Q: What do I do about an error message that says: GPF in Module ???.DRV ?

A: These error messages are often related to the video driver being used by Windows. Many can be 
resolved simply by changing the video resolution to 640x480 with 256 colors. Also make sure your 
system is up-to-date with the latest drivers available for your video card. These can usually be obtained 
from your video card manufacturer.

As an alternative, we have included Microsoft's Super VGA drivers on the CD. To load the SVGA video 
drivers, follow the steps below.

Note:    If you have a 2MB accelerator card installed on your system, we strongly recommend that you 
contact the video manufacturer instead of loading this SVGA driver.

1. Open the program group called Main in the Program Manager and double-click on the Windows 
Setup icon. 

2. Open the Options menu and select Change System Settings. 
3. Make note of the current setting in the Display box in case you need to return to it.
4. Click on the down arrow on the right side of the Display box, scroll through the list of drivers, and 

select Other Display. 
5. Windows will ask where the video drivers can be found. Type x:\svga (replacing x with the letter of 

your CD drive) and press Enter. You will be presented with a list of available drivers and settings. 
Select either 800x600, 256 colors, small fonts OR 640x480, 256 colors and click OK.

6. When the driver has been loaded, Windows will need to restart to activate the new video driver. 



WAV and MIDI Music Issues
Ultimate Children's Encyclopedia    makes full use of the capabilities of the sound card in your computer. 
The specific features of your sound card depend on your system, but the tips below offer some general 
suggestions to help you get better results with the sounds and MIDI music in the program. For more 
detailed information, consult the user's guide for your sound card.

* Most sound cards come with mixer software that lets you change the level (volume) of individual 
sound sources, as well as the overall volume of all the sounds your computer plays. As you explore 
Ultimate Children's Encyclopedia, experiment with your mixer software until you find the best 
combination of levels for playing recorded audio (for example, a bird call) and MIDI music (for 
example, a waltz by Brahms).

* Once you've found the mixer setting that works best with Ultimate Children's Encyclopedia, save 
those settings so you can use them again. Most mixer software allows you to do this by creating a mix
or preferences file.



Contacting Technical Support
Please take a moment and look over some of the questions you will be asked when you contact Tech 
Support. We need this information to provide an effective solution to your question.

* Which product do you have? The product title and version number is printed on the CD.
* Are you at the computer? This makes all the difference in effectively troubleshooting an error 

message or conflict on a computer system.
* What kind of computer system do you have? It might be an IBM, Compaq, Mac, or maybe a clone.
* Which operating system are you using, Windows 95 or Windows 3.1?
* Did you buy the product separately or did it come with a computer or other hardware? Occasionally 

issues arise with various software and hardware combinations. Knowing which components are 
installed in your system will help us find the best solution for you more quickly.

* What is the program doing or not doing? If there is an error message, please write it down so you can
tell us exactly what it says.

* What was the program doing just before this problem occurred? This will assist us in duplicating the 
issue. 

* Have you tried turning your computer off and back on again? This often clears minor errors.

You can contact The Learning Company Technical Support vie E-mail at support@softkey.com. 

If you prefer the mail, our address is:

SoftKey Product Support Center
9715 Parkside Drive
Knoxville, TN 37922

For Technical Support by phone, see the readme.txt file on this CD for the phone number and additional 
information.



Details About the Dictionary and Thesaurus
In the dictionary and thesaurus you can have fun finding out about the meaning of 
words, and enrich your vocabulary and word power. You can also find out more about 
the world around you, and about countries and places.

* In the dictionary and thesaurus, the headword for each entry appears in bold 
type. Alternative spellings and irregular and alternative plural forms of nouns are 
also shown in bold type. The plural of most nouns is formed by adding -s.

* The part of speech appears in abbreviated form and is printed in italics: n., vb., adj., 
adv., pron., conj., prep., and interj., for noun, verb, adjective, adverb, pronoun, 
conjunction, preposition, and interjection.

* In the dictionary, other forms of verbs are shown. For example, within the entry for 
belong, you will find the present participle, belonging; and the past tense and past 
participle, belonged.

* Other forms of adjectives--using the -er and -est endings--are usually only shown 
where the spelling of the main word changes, for example, with ugly: uglier and  
ugliest. Some longer adjectives take more and most instead of    -er and -est: more 
successful and  most successful.

* A repeated spelling with a small number above the headword means that there are 
two or more words spelled in the same way but with unrelated meanings, for 
example, bear1 and  bear2. These are called homographs.

* Numbered definitions within an entry give a different meaning or use of the word. 
Nouns, verbs, and adjectives are grouped and numbered.

* An example sentence or phrase after a definition shows how the word is used. The 
example sentence is printed in italic type.

* Idioms appear in bold type at the end of an entry. An idiom is a phrase with a 
different meaning from that of its individual words, for example: a bee in your bonnet.

* In the thesaurus, words that have the same or a similar meaning to the entry word 
follow the headword and part of speech. These are the synonyms. So after the word 
ask, for example, you will find the words: demand, request, questions and 
interrogate.

* If a word has an antonym--a word with an opposite meaning--it is shown at the end 
of the entry in bold italic type. So, for example, at the end of the entry for cold,  you 
will find the antonyms: hot and warm.

* If a word has a homonym--a word with the same sound but a different spelling--it 
appears at the very end of the entry in SMALL CAPITAL LETTERS. So, for example, at the 
end of the entry for bear, you will find the homonym: BARE.
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Journal
Among the handy research tools you'll find in my goggles, my favorite is probably the 
journal. Anytime you want to jot down a few notes, just click the Journal button at the 
top of the screen. Your word processor will open and you'll be set to start typing away.
When you find text or a picture that you like, you can copy it and paste it into your 
journal so you'll have it to use or refer to again later.
To copy text to your journal, follow these steps:

1. Use your mouse to select the text you want to copy.
2. Click the Copy button, select the Article button, and click OK. 
3. Click the Journal button to open your journal.
4. Open the Edit menu in your journal file and select Paste.
To copy a picture into your journal, follow these steps:

1. Be sure the picture you want to copy is on screen.
2.  Click the Copy button, select the Media button, and click OK.
3. Click the Journal button to open your journal.
4. Open the Edit menu in your journal file and select Paste.
An important note about copying: Please remember that the materials in Ultimate 
Children's Encyclopedia are copyrighted. That means that the text and multimedia in the
program belong to the companies who created them.
You may quote the text and copy the multimedia for school or personal use. If you use 
materials from Ultimate Children's Encyclopedia--in a report, for example--be sure to 
include the proper credits in your bibliography.

Using someone else's work without giving due credit is called "plagiarism." 



Icons

If you see a Pronunciation icon by the article title, click it to hear the name of a person,
country or other item pronounced out loud.

If you see a Related Articles icon, click it to see a list of articles that are related to the 
one on screen. Click a title in the list to go to the related article. To return to the original 
article, click the Go Back arrow in the top left corner of the screen. To close the Related 
Articles list, click Forget It.

If you see a Picture icon, click it to see another picture.

If you see a Picture Fact icon, click it to see a description of the current picture. When 
you're done reading the description, click Forget It to close it. If you come across a 
word you don't know, click it to see its definition.

If you see a Sound icon, click it to hear a related sound clip.

If you see a Sound Fact icon, click it to read about the related sound clip.

If you see a Movie icon, click it to see a related video.

If you see a Movie Fact icon, click it to read about the related video.



If you see a Timeline icon, click it to open a view of the timeline that is related to the 
current article.

If you see a Fact icon, click it to read a short, interesting fact related to the current 
article.

If you see an Atlas icon, click it to see a view of the atlas related to the current article.



Copyrights
A Note to the User
All images reproduced in this product, including photographs, drawings, maps, and 
videos, are protected under international copyright law. No reproduction or reuse of this 
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Copyright Responsibilities

This software program contains copyrighted materials which are licensed to you for your personal use, 
subject to the terms of the SoftKey License Agreement included with this software package and the statement below 
entitled "Use of Animations, Photographs, Images, Videos, Text, Music and Sounds". It is illegal to duplicate or 
distribute any part of this software program, except as stated in the SoftKey License Agreement and as detailed 
below.

Use of Animations, Photographs, Images, Videos, Text, Music and Sounds

Subject to the restrictions described below, you may use the Animations, Photographs, 
Images, Videos, Text, Music and/or Sounds contained in this software product (the "Content") 
for your personal, non-commercial use in connection with private presentations, private reports, 
academic non-published reports, and other similar non-public uses.    You may also publicly 
display or demonstrate the software program in unaltered form on your computer.

1. You may NOT include the Content in any item that is offered for sale.    

2. You may NOT modify or alter the Content in any way.

3. You may NOT incorporate the Content into any materials which are publicly distributed or 
displayed, including, any such advertisements, public presentations (including public multimedia
presentations), greeting cards, invitations, announcements, calendars, catalogs, or other similar 
uses.

4.      You may NOT resell, sublicense or distribute the Program or any of the Content in any 
electronic form, including, on any on-line service or the Internet.    For example, you may NOT 
include Content in another software product for resale, or distribute the Content on any on-line 
bulletin board service or place the Content on a Web page.

5. You may NOT use photos or images of people or identifiable entities in any manner which 
suggests the endorsement or association of any product or service or in connection with any 
pornographic or immoral materials. 

6.        You must credit the software program as follows: (c) 1996 SoftKey International Inc. and 
its licensors.



Goggle Features
My goggles are equipped with several handy tools and features. Click on an item below 
to learn about it.

Journal
Copy
Print
Go Back
Go To Room
The Dictionary & Thesaurus
All About Words
Quit
Settings
Find
Help



Sound Fact Icon
Click the Sound Fact icon to read about a sound clip related to this article.



Movie Fact Icon
Click the Movie Fact icon to read about a video related to this article.



Go Back
Click the Go Back arrow in the top left corner of the screen to return to the previous 
screen.



Go To Room
Click Go To Room to return to my room at any time.

 




